
TurboCAD LTE 2021 New Features 
 

User Interface & Usability 

 

1. Keyboard Shortcuts: 

TurboCAD LTE 2021 (Both variants) 

This brilliant new feature is set to revolutionize the way people use TurboCAD LTE! The user 

now has the ability to set up keyboard shortcuts that consist of either two or more keystrokes 

to quickly invoke any TurboCAD LTE command 

 

2. Isolate and Hide Objects: 

TurboCAD LTE 2021 (Both variants) 

This terrific new feature allows you to take a complex drawing and to quickly reduce its 
complexity by allowing you to select certain entities and to isolate them independent of layers 
or groups. In addition to isolating certain objects, you also have the choice of hiding additional 
objects so that you can focus only on the entities that are important during the editing 
procedure. When complete you can simply hit the Unhide option and the drawing will return 
to its previous state. 



There are three options for isolation: 

I. Isolate Objects:  

                        “Isolate object” hide all objects except selected object in the larger drawing 
temporarily.  

 

 

 

II. Hide Objects:   

 Hide Objects” Hide selected object in the drawing temporarily. 

 

III. End Isolation: 



  Click End Isolation to show the all objects. 

 

3. Select by Entity Type. 

TurboCAD LTE 2021 (Both Variants)  

Now Circle/Ellipse item of previous TC LTE versions is separated into two cases: Circle or 
Ellipse. The same is for Circular and Elliptical arcs. Previous versions could not select Circles or 
Arcs separately. 

 



 

 

4.  Customizable Ribbon Configuration 

TurboCAD LTE 2021 (Both variants) 

TurboCAD LTE boasts a new variety of excellent user interface i.e. RIBBON INTERFACE similar 

to that found in Microsoft Word and the latest versions of AutoCAD.  

 



Users now have the ability to fully customize the Ribbon Interface.  You can now Add and 
Rename Tools, Groups and Tabs.  In addition, Tabs may be hidden or renamed, and manually 
created XML Config files can be directly imported into TurboCAD LTE. UI Themes are also fully 
supported in the Ribbon. 

   

In Customize Ribbon, the following options are available 

Add: Adds a selected tool into the tab that has been selected. 



 

Remove: Removes a selected tool from a tab. 

Rename: Rename a selected menu tab using this button. 



 

New Tab: This button adds a new Menu tab. 

New Group: Creates a new group in a selected menu tab. 



 

Hide Tab:  Unchecking the tab will hide tab from the Ribbon. 

 

 



Move Tabs: Tabs can be repositioned using up/down arrow buttons. 

 

Import Ribbon: Manually created custom(.xml) config files can be imported and used in 
Ribbon UI. 

 

 

 

 



5. Select by Similar - Select objects with shared or similar properties tool 

TurboCAD LTE 2021 (LTE Pro only) 

Overview 

A powerful new tool that allows you to select any 2D or 3D object type or a Block and then find 

all occurrences of that in the drawing.  Very detailed selections can be made that include 

parameters such as pen color and style, brush color and style, layer, even the selected object’s 

coordinate system. A great tool to use in conjunction with making further global changes to 

that selected object. 

To Use:  

● Select an object in the drawing 

 

● Then go to the Edit menu and choose Select by Similar: 

● After choosing Similar, a new Dialog box will appear which will let define which of the 

selected object’s parameters will be selected: 

 

Result: All the objects that are on the same layer as the selected object will be selected 

automatically. 



 

Note: This command is only accessible after you have selected an object. 

 

6. Construct Similar 

TurboCAD LTE 2021 (LTE Pro only) 

The “Construct Similar” tool takes properties from one object and applies them onto active 

tool. You can set an object's properties before it is created in one click.  Analogous to the 

‘Format Painter’ tool found in MS Office applications. The tool is found on the main toolbar of 

the program. 



 

 

To use Construct Similar, first choose the Object type you wish: 

 

Menu item is enabled if the active tool is a tool for the construction geometry (‘Draw Line’, 

‘Draw Arc’ etc.). 

Command Description: Construct similar object 

Tool Prompt: Select the entity to construct similar 

 



 

7. Audit System  

TurboCAD LTE 2021 (Both variants) 

A new “Audit” item has been added to the Filters menu of the Selection Info Palette. This Audit 
System enables you to highlight ‘bad’ objects in Selection Info palette, turn on/off audit 
conditions and change their parameters, generate audit report for one or more objects, filter 
‘bad’ objects in Selection Info palette, send notifications (about a ‘bad’ object) to Event Viewer 
palette. 

 

 

 -   New item “Audit” was added to menu “Filters”. 

 



 

-   The possibility to highlight ‘bad’ objects in Selection Info palette 

-   The possibility to turn on/off audit conditions and changing their parameters 

-   The possibility to generate audit report for one or more objects 

-   The possibility to filter ‘bad’ objects in Selection Info palette 

The possibility to send notify (about a ‘bad’ object) to Event Viewer palette  

 

 

         

"Audit" report (HTML page).  

 

 



“Audit” section 

 

 

 

 

8. Changing the styles of Ribbon icons with a lack of free space 

TurboCAD LTE 2021 (Both variants) 

When using the Ribbon Interface, as you change either the UI Scale or Icon size through the 
Options/Toolbars and Menus /Options menu, the Size and Style (with or without text) of the 
icon will dynamically change. 

9. Repeat Last Command 

TurboCAD LTE 2021 (Both variants) 

The new Repeat command allows user to repeat the previous command with a single click. 

 



 

 

10. Acceleration of the generation of Drafting Objects 

TurboCAD LTE 2021 (LTE Pro only)    

The creation of Sectional Views and Objects in the Drafting Palette has been significantly 
accelerated.  

 

11. GDI Redraw speed improvement in case of a lot of small graphics 

TurboCAD LTE 2021 (Both Variants) 

For drawings containing lots of small objects, redraw speed has been accelerated. 

 

12. Command-line: 4K monitors and dark theme support 

TurboCAD LTE 2021 (Both variants) 

New options have been added to the Command Line that allow for support of the Dark user 
interface theme. 

With new, scalable vector icons, TurboCAD LTE is now fully optimized for 4K monitors. Through 
dynamic sliders, toolbar icons, the User Interface and other icons in other part of the UI can be 
resized to optimize readability on higher resolution displays. 



 

 

13. Image Manager Improvement 

TurboCAD LTE 2021 (LTE Pro only) 

 You can now select multiple files from Open Dialog box when importing pictures in the Image 
Manager palette.   



 

 

14. Improved Inspector Bar functionality 

TurboCAD LTE 2021 (Both variants) 

Added the ability for users to use not only Text/Numeric fields and button controls, but 

“combo box” controls as well. This functionality allows users to reduce using the Tool's Local 

menu and reduce Inspector bar size. 

 

15. Ribbon Large/Small icons, available space icon sizing 

TurboCAD LTE 2021 (Both variants) 

A new local menu option has been added when right-clicking on a Ribbon icon Users can now 
change the icon size/icon text to “Large Image and Text”, which allows for display of a larger 
image of the tool icon with associated text.    

 



   

 

 

16. Find Control in Custom Ribbon Page 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: The Find feature allows users to search or find Command/Group/Pop-
ups/Tabs in the Ribbon tree. 



 

 

17. Interactive Startup Splash Screen  

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: Splash Screen has been added as a Startup Screen when Launching TurboCAD 
LTE for a better interactive user interface.  The interactive screen displays recently created files 
and ability to open/create new file via Create tab, allows user to learn about TurboCAD LTE 
basics, including new feature videos, via Learn tab, and get access to the latest information 
about TurboCAD LTE, via News tab. 

 

18. Resize Previews in Blocks Palette 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: A new slider has been added to the Blocks Palette which allows the user to 

resize previews of blocks within the Blocks Palette. 



Before:                 After:     

       
 

 

 

 

19. Mouse Wheel Support within the Blocks Palette 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: Using the mouse wheel, the user can now scroll through block previews 

within the Blocks Palette. 

 

20. Currently Available On  

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: A new feature has been added to the Commands section in the Customize 

menu, which allows the user to see the position of a particular command available in the 

menu, UIs and toolbars. 



 

 

 

21. Viewport Hidden Line Performance Improvement 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: A new option “Use Hidden Line Cache” has been added to the cache section 

of the Viewport properties window. If this is turned on, Paper Space viewport processing 

(redraw, move, zoom) becomes significant faster for large drawings. 

 

Architecture and Construction 

 

22. Multi-Landing Stairs by Path 
TurboCAD LTE 2021 (LTE Pro only) 
 

Creation of stair, using polyline as path 
Stair height defined by the last polyline vertex (z value) 
Stair riser height and risers count calculated from stair height and riser depth 

 

23. Relative Angle fields for Wall and Polyline update 

TurboCAD LTE 2021 (LTE Pro only) 

While drawing walls or polylines, you can now choose to enter an Angle (which is absolute in 
relation to the world coordinates) or a Relative Angle which is the angle from the immediately 
previous segment (arc or line).  



For the Wall tool, the Relative Angle is always enabled. At the first state we draw a straight 
wall (the relative angle is enabled) 

The Relative Angle is also enabled with Curved Walls.  

 

24. Array and Copy tool Improvements, performance enhancements for ADT 

Objects 

TurboCAD LTE 2021 (LTE Pro only) 

Architectural Desktop (ADT) objects can now be completely and accurately used with Copy and 
Linear Array copy tools.   For example, the Array Fit Linear now takes into account all of the 
properties of the ADT object being copied, including Work Plane, Layer etc. Previously, this 
tool could create only one roof object. Now, multiple objects may be created.  In addition, the 
overall processing of all ADT objects in a drawing, including the House Wizard, has been 
significantly sped up. 

 

25. Add Roof by Walls tool improvement 

TurboCAD LTE 2021 (LTE Pro only) 

Previously, this tool could create only one roof object. Now, multiple objects may be created. 

 

 

 



 

26. Stair by Linework 

TurboCAD LTE 2021 (LTE Pro only) 

Create stair by linework (similarly as in AutoCAD Architecture) 
 
Line work is set of lines/polylines/arcs/curves. 
It cannot contain "self-intersecting" graphics (contours) 

 

27. Openings modifier 

TurboCAD LTE 2021 (LTE Pro only) 

A new “Auto Modifier" option has added. With this option enabled, the Opening (wall clipping 

contour modifier will be generated automatically. Previously the Opening modifier had to be 

manually defined. If the opening modifier was not defined, then a rectangle (opening extents) 

was always used to make a hole on the wall.  Only 3D objects are used as modifiers. 

 



 

 

28. Architectural Grid 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: The Architectural Grid is a new tool that makes it easy to align other 
architectural objects in the drawing, such as walls and columns. Users can also import 
rectangular grids from DWG drawings and can change the properties of the grid and bubble 
representation, via the Selection Info palette. 

 



 

 

 

 

2D Drafting and Editing 

29. Arrow Tools 

TurboCAD LTE 2021 (LTE Pro only) 

 
There are four Arrow tools which allow you to quickly create arrows to annotate your 
drawings. 

 

• Arrow Arc 

• Arrow Curve 

• Arrow Line 

• Arrow Polyline 

 Results and Properties of using Arrow Tools: 

 

   



 

30. Remove Overlapping Entities Tool 

TurboCAD LTE 2021 (Both variants) 

This new ‘overkill’ tool allows the user to eliminate overlapping lines and arcs, thereby 

allowing for the simplification of drawings by removing duplicate, redundant entities. 

Local menu options: 

Combine Overlap: Combine collinear objects that partially overlap into single objects. 

Color, Layer, Line Type: select these LM items to not ignore objects properties during 

comparison. Event viewer shows the count of object that was changed (duplicated). 

"Remove duplicate" functionality is working for Polylines, circle arcs, text, m-text, dimensions. 

 

31. Trim by Entity 

TurboCAD LTE 2021(Both variants) 

This interesting new command allows trimming of multiple entities by using a single 2D close 
profile as the cutting edge. All objects within the defined profile are trimmed and removed. 
This allows you to avoid having to select multiple objects to trim to just one cutting edge.  

Select as closed 2D object to cut another object/ object placed inside it. 

i. Select a closed 2D object (cutter). 

ii. Transform/ move the selected cutter to cut the object inside it. 

 



  

 

● Single Entity to trim:  
i) Enable ‘Define entity to trim’ in the inspector bar.  

ii) Move the selected cutter to cut the defined object.  



 

 

 

32. Highlight End Points  

TurboCAD LTE 2021 (Both variants) 

A new local menu item “Highlight end points” (On/Off) has been added to “Edit” tool. This 

item is available for the following object types:

- Polyline 

- Polyline 3D 

- Double Line/Walls 

- Spline/Bezier



 

The item is enabled if the selected graphic is non-closed and if vertex count > 2. If “Highlight 

end points” option is ‘on’, then endpoints are marked in red. 

 

 

33.  Closed property for Polyline 

TurboCAD LTE 2021 (Both variants) 

A property called ‘Closed’ has been added to the Selection Info palette, with this property, 

users can determine if a Polyline is closed or not. This is extremely important when performing 

functions such as Extrudes and Lofts.  



 

 

34.  Trace Tools - Trace by Point and Trace by Rectangle 

TurboCAD LTE 2021 (LTE Pro only) 

Trace tools (Trace by Point and Trace by Rectangle) are now supported in the new version of 

TurboCAD LTE. 

35. Text dragger: Ability to use degree, plus/minus, diameter signs while 

entering text 

TurboCAD LTE 2021 (Both variants) 

TurboCAD LTE now supports Special Signs when inserting text into your drawing. The local 
menu includes Degree, Plus/Minus, and Diameter signs to use. 



 

 
 

36. Snap between two points 

TurboCAD LTE 2021 (Both variants) 

Snap between two points allows you to have two subsequent points to let you snap to the 
middle of them. 

 



 

 

37. Best Fit Circle and Line  

TurboCAD LTE 2021 (Both variants) 

The new Best Fit Circle and Line tools allow the user to draw a circle which is best-fitted 
through 3 or more defined points or a line through 2 or more points. Points can be extracted 
from a specified location or from a specific object. 

 

                        

  



 

 

 

38. Auto-Numbering Feature 

TurboCAD LTE 2021 (Both variants)  

The Auto-numbering tool allows you to select multiple text entities and have them auto-

numbered.  Numbers are placed either at the end of each text block or can replace the text 

block. 

 

39. Snap Improvement: Highlight Hit Graphic 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy:  This feature highlights edges for snaps when you move 3D object or connect 
two, 3D objects together. This option has been added to both the Drawing Aids window and the 
related settings have been added to the Program Setup/Preferences dialog box as Visual Effect 
Settings, selected – Visual Effect Settings. 

 



 

 

 

 

40. OK and Cancel button added to Insert Fraction dialog box 

TurboCAD LTE 2021 (Both variants) 

Improved usability by the addition of OK and Cancel button in the dialog box of the Insert 
Fraction in the Text Editor palette.  

 

 

 

 



 

41. Named View Enhancements 

TurboCAD LTE 2021 (LTE Pro only) 

New functionality has been added where users now have the option of associating Layer Sets with 

Named Views, giving users a much better way to manage Layers Sets. 

 

 

 

Associating a set of layers with Named Views 

New functionality where you have the option of associating set of layers (Layer Sets) with 

Named Views. In addition to giving users a much better way to manage Layers Sets, this new 

feature lends itself to easier Viewport creation. 

 

 

42. Extents Size property 

TurboCAD LTE 2021 (Both variants) 

The Extents Size parameter has been added to the selection Info palette properties.  Extents 
Size parameter works with groups, blocks and insertions. You can now use the ‘Extents size’ 
property to select entity according to size valuation. Select objects that you think are big or 
small, or object in any range you want.  



 

The Extents Size update provides you with additional flexibility so that you can use this 
parameter for various needs and for analyzing wrong entities. 

 

 

43. Find Block in Blocks Palette 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: A new search bar has been added to the Blocks Palette which allows user to 

find a block by its name in the Blocks Palette. 

 

 

 

44. Angular dimension tool improvement 

TurboCAD LTE 2021 (Both variants) 



 

The Angular Dimension tool has been improved with a Local Menu option that is enabled when 

the Angular Dimension tool is selected. 

 

This new option allows the user to define an obtuse or acute angle dimension based upon the 

user selecting a vertex point on a 2D object and then defining 2 additional points which define 

the angle. 

Steps to use: 

1. Select the Angular Dimension tool from the Dimension sub-menu - Draw / Dimension 

2. Right-click and select the Local Menu option 'Angle Node' 

3. Click on the vertex of 2D entity 

4. Define the first angle endpoint 

5. Define the second angle endpoint 

After clicking the second angle endpoint, the obtuse Angle Node dimension is displayed.   To 

see the acute Angle Node dimension, move your mouse cursor down away from the display of 

the Obtuse Angle Node Dimension. 



 

 

 

 

45. Zoom in Print Preview 

TurboCAD LTE 2021 (LTE Pro only) 

Previously, it was not possible to zoom in and out using the wheel mouse on the print preview. 
Now user is able to zoom in in Print Preview windows, prior to printing to be sure things are 
looking correct Such as line thickness etc. 



 

 

 

 
46. Table Import and Table export 

TurboCAD LTE 2021 (LTE Pro only) 

Table import enables you to create a table based on a sheet from an Excel (*.xlsx) File. 

 

Table Export allows you to save a table as an Excel (*.xlsx) file. 



 

 

 

47. Pick Point Hatch Improvement 

TurboCAD LTE 2021 (Both variants) 

This Hatching tool now works with gaps in 2D objects. For example, trying to fill an area 

bounded by a Polyline, when there are gaps in the Polyline.  Improvements to pick-point also 

apply to ADT objects (Walls, Doors and Windows), allowing to similarly fill in gaps between 

these objects.  



 

 

 

48. Improved Coordinate Measure tool to include 3D 

TurboCAD LTE 2021 (Both variants) 

In earlier versions of TurboCAD LTE, the Measure Coordinates of the Point tool could only 
measure the X and Y values as it functioned like a 2-D tool fixed on the active workplace. Now, 
the measure coordinates tool behaves more like a 3D tool in that will show the 3D coordinate 
of the World coordinate system independent of the active user coordinate system. 

 

49. Block and Group Editing Mode indicator bar 



 

TurboCAD LTE 2021 (Both variants) 

When editing a Block or Group, a (new) small toolbar appears in the upper-left corner of the 
drawing area. The toolbar displays the Block or Group name and includes a ‘Finish’ icon to 
return the user to the main Model Space. 

 

 

50.  Improved 3D Snap 

TurboCAD LTE 2021 (LTE Pro only) 

Now, the intersection of two, 2D objects not in the same Work Plane can be snapped to.  Useful 
for 3D modification tools such Lofting, Covering and Extrusions. 

 

 

51.  Drafting Palette: Ability to select Layer Sets & Scale Drafting Objects 



 

TurboCAD LTE 2021 (LTE Pro only) 

As with Paper Space View Ports, the Drafting Palette now has an Option to select a Layer Set. 
The Layer Set can contain both visible and non-visible layers. This same Layer Set addition has 
been added to the Drafting Object via the local menu Properties 

Other than this, users can also define the Scale of Drafting Object through the local menu 
Properties of the Object. 

 

 

 

52. Quick Dimension improvements 

TurboCAD LTE 2021 (Both variants) 

A new local menu option to the Quick Dimension tool now allows the user to dimension a 

Group of Graphics, such that the maximum X and Y-axis sizes of the Group are displayed.  

 

53. Show Block insertion tree 

TurboCAD LTE 2021 (Both variants) 

The Selection Info palette now shows the block insertion structure. 

This feature does not allow the editing, only visualization of the structure. 



 

 

 

54. Point of intersection for Dimensioning 

TurboCAD LTE 2021 (LTE Pro only) 

The Apparent Intersection SNAP now works with Drafting Objects created in the Drafting 

Palette. 

 

 



 

 

55. Automatic Updating of Xrefs 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: When using a file with Xrefs, if any of those external files are updated, then 

TurboCAD LTE now asks if you want to regenerate the file with the updated Xref. 

 

56. Leader Dimension Improvements 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: Leader dimensions in DWG files are now displayed correctly with TC LTE 2021. 

 

 

 

57. Load/Unload Xrefs 

TurboCAD LTE 2021 (Both variants) 

Marketing Copy:  A New option “Status”, with two values: “Loaded” and “Unloaded” has been 

added to the Edit Xrefs dialog box. When a referenced drawing (Xref) is Unloaded from the 

current drawing, the drawing opens much faster and uses less memory. 

When the Xref definition is unloaded from the drawing file, the internal pointer to the 

referenced drawing remains. You can therefore restore all the information by Loading the Xref. 

In order to maximize the performance of TurboCAD LTE, it is recommended that you Unload 

any referenced files if they are not needed in the current drawing session but may be used later 

for printing/plotting. 



 

 

. 
58. Edit Selected Block command 

TurboCAD LTE 2021 (LTE Pro only) 

Marketing Copy: Now user can edit the selected block directly within the TurboCAD LTE 

drawing without having to select the Edit Content option from the Blocks Palette. This can be 

done by simply selecting the block and clicking “Edit Selected Block”, now added to the menu. 

 

 

 

Rendering and Visualization 

59. Visualize Render Mode  

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: A new render mode “Visualize” has been added to the TurboCAD LTE 2021. 

Visualize supports several device modes: OpenGLES2, OpenGL and GDI, out of which 

OpenGLES2 is the most advanced and the most productive device mode. 

 

a. Visualize Hidden Line and Draft Render Mode 

Marketing Copy: 'Visualize’ Rendering Type with both Hidden Line and Draft Render (including 

‘Gouraud Shaded’ and ‘Flat Shaded’) modes has been added to ‘Camera Properties\Rendering’ 

page. 



 

    

 

 

 

Visualize Wireframe vs Hidden Line vs Draft Render: 
 

 

 

b. Visualize Import LightWorks® and RedSDK materials 

Marketing Copy: The Visualize rendering technology includes the ability to import materials 

contained in TurboCAD LTE files that have been rendered either by LightWorks or RedSDK.  

The Visualize renderer does not currently include its own native materials for TurboCAD 

LTE.  Currently, Visualize rendering supports color, texture, transparency map and bump 

maps, these parameters can be imported from LightWorks or RedSDK materials. 



 

 

 

c. Visualize Anti-Aliasing 

Marketing Copy: The Visualize renderer supports two types of Anti-Aliasing: Line Smoothing 

and Fast Approximation Anti-Aliasing (FXAA). 

 

 



 

 

 

 

 

 

d. Visualize Ambient Occlusion 

Marketing Copy:  An Ambient Occlusion option is included in Visualize. Options for these 

are set in the Drawing Setup dialog box, and include the following parameters: Loops, 

Focus, Power, Blur Radius, Blur Power. 



 

 

 

e. Visualize Lighting 

Marketing Copy: Lighting options are included in Visualize. Options for this are set in 

Drawing Setup dialog box, and include the following parameters: Default Presets, Intensity. 

This could get enabled with OpenGLES2 device type. 

 



 

 

f. Visualize Support images with alpha transparency 

Marketing Copy: Support of images with alpha transparency is included in Visualize. When 

the Opaque Background option is disabled (it is enabled by default), it makes all pixels of a 

certain color transparent (100% transparency). In Visualize mode, the transparency of each 

pixel corresponds to the alpha transparency value for the given pixel, specified in the alpha 

channel. 

 

 

 

g. Visualize Settings 



 

Marketing Copy: Visualize Settings have been added to the Program Setup window.

 

 

Interoperability 

60. PDF Enhancements 

 

a. PDF Tools: Import PDF Page as vector Page, PDF Insert / Underlay  

TurboCAD LTE 2021 (LTE Pro only) 

2D Vector PDF files can now be directly imported into TurboCAD LTE as a vector page. The file 
can be imported as either a TurboCAD LTE Object or Group of Graphics.   
The PDF Underlay tool allows you to insert a page of a PDF file into your drawing to use as 
reference or tracing layer. To use properly as a tracing layer, the file must be a vector PDF, 
rather than a bit-mapped PDF. 

b. Publish to PDF  

TurboCAD LTE 2021 (Both variants) 

Marketing Copy: Publish to PDF Combine functionality of 2D and 3D PDF filters have been 

integrated into a single tool “Publish to PDF”, which has been added to the File menu. 



 

 

 

 

 

 

6. DWG/DXF filter 

TurboCAD LTE 2021 (Both variants) 



 

TurboCAD LTE now supports AutoCAD 2020 DWG/DXF formats. Now the IFC filter correctly 

export/import PPM objects that using as wall openings. 

 

7. SKP filter: 2021 Support 

TurboCAD LTE 2021 (LTE Pro only) 

The SketchUp SDK is updated to support the latest SKP file format (2021) for TurboCAD LTE 

2021. 

 

8. STL Import Performance Boost 

TurboCAD 2021 (Both variants) 

Marketing Copy: STL file import performance has been boosted up to 10 times. 

 

  



 

Other Improvements: 

1. Improved Block/Group Editing - Support snaps for background graphics 

2. Improved Format Painter Tool - Ability to use Format Painter to transfer Custom 

Properties and PSD 

3. Improved PNG support - Moved to CxImage engine to support large image export 

4. Improved Nudge functionality - Now you can nudge object (currently always on 1 pixel) 

using the Number Keypad (may require Num Lock to be on depending on keyboard) 

5. Construction lines should not delete with isolation command 
6. Keyboard. Showing custom keyboard shortcuts in local menu.    

  
7. Keyboard options. Report on commands. 

8. Block Palette Enhancements - There is a new button in the block palette - "Options" 

There is a new option "Compensate for the offset of the base point..." 

to allow to reset a block's reference point to after using Edit Reference point is used on 

inserted Block. 

9. House Wizard Improvements - House Wizard can be used on different work planes. 

Rooms on the parallel planes can be aligned relative to each other. 

Walls are built separately for each work plane. 

10. Multiline Text Improvements - UI. Palette is used instead of modeless dialog. 

Multiline Text in place Editor (similar AutoCAD) 

s 


